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This Month’s May Meetings 
 

General Meeting 
Tuesday, May 14th at 6:00 P.M. 
At Christ Lutheran Church FFG 

 
Plateau Photography Club Workshop 

Thursday May 16th at 1:00 P.M.  
At FFG Library Bldg. 
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The May 14th Program at  6:00 P.M. 
FFG Christ Lutheran Church 

 
What is this Chromebook thing? 

 
Jim Gries will be giving a presentation on 
Chromebooks.   
 
He will go through the history of computers 
and how the Chromebook came about.  The 
presentation will cover the differences between 
PCs or Mac and the Chromebook.   
 
He will provide the advantages and disad-
vantages of a Chromebook and why it is be-
coming the go to computer for the non-techies 
among us. 
 
Attend the presentation and see why you should 
seriously consider a Chromebox when you get 
your next computer.  
 
 
 

Winter Hours  start at 3:00 P.M. (October through March) 
Summer Hours start at 6:00 P.M. (April through September) 
 
Location:  Christ Lutheran Church 

481 Snead Drive, Fairfield Glade 
 

NOTE:  Meeting Dates are now on 2nd Tuesday’s of the month  

Monday, May 27, 2019 

mailto:www.PPCUGinc.com
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Join the Club! 
Anyone interested to attend the general meeting or any of the 
SIG meetings as a guest will be charged $3.00 per person for 
any or all meetings in that month. Afterwards, you are en-
couraged to become a member of the Plateau PC Users 
Group.  
Our Club cannot exist without you, the members.  
  
Membership Dues  

Our annual dues are now payable July 1st of each year.   
Annual dues are $24 per single person / $30 per family  
starting July 1, 2014.with partial years dues as follows: 

  
 
 

 
 
 
 
 
 
 

Student memberships (21 and under) are $10 annually.   
Corporate memberships are $30 a year for the first two  
memberships and $10  a year for each additional  
membership from the same company.   
Contact the PPCUG Treasurer (931) 707-3677  
for pro-rated dues of these types of memberships. 
 

BOARD OF DIRECTORS DISCLAIMER 
 

All members of the Plateau PC Users Group are willing to 
help one another in the area of advice and tutorial instruc-
tion over the phone.  If you should require more involved 
services or instruction, we have a few members who are 
very knowledgeable in several areas.  As a responsible  
consumer, it is up to you to discuss, before retaining a mem-
ber, any and ALL charges for repair services and time con-
suming tutorial activities. 
 
It is not the desire of this Board of Directors to set fees for 
individuals for services rendered, nor the responsibility to 
intervene between members who enter into a contract 
among themselves. 
 
The GAZETTE is published using the following:  Microsoft 
Word, Microsoft Publisher, and Microsoft Windows.  The 
Gazette is the monthly newsletter of the Plateau PC Users 
Group, Inc. 
 
DISCLAIMER:  No warranty, express or implied, is made 
by the PPCUG, the Gazette editorial staff or its contributing 
editors.  This extends to all losses incidental or consequen-
tial from the use or non-use of any information in any issue 
of the Gazette. 
 
All images used in the newsletter, website, blogs, class mate-
rials or handouts (“media”)  are obtained from a “free use” 
source, preferably images that have been released as “CCO 
Public Domain”. 

 
2018-2019 PPCUG, Inc. Board Members 

President Steve Rosenstein (931) 742-0151 

Vice-President/  
Compliance  

Jim Buxton (931) 456-6009  

Treasurer John Krueger (931) 707-3677 

Acting Secretary Linda Yates (619) 707-7339 

Past President Carl Nordeen  (931) 456-5597 

Membership John Krueger (931) 707-3677 

Publicity Mary Anne Nordeen  (931) 456-5597 

Gazette Editor Gordon Botting (931) 456-2184 

APCUG Rep  Steve Rosenstein (931) 742-0151 

Equipment  
Custodian 

 Bob Willis (931) 456-6511 

Webmaster Alan Baker  (931) 239-0877 

   

Directors at Large 

Gordon Botting Richard Del Frate Barbara Duncan 

Bob Willis Charlie Merrick  

   

 

    

 SIG Leader   

Plateau Photography 
Club Workshop 

Jim Gries 
 

FGphotography-
club@gmail.com 
(331) 442-9763 

   

 
Join In 

Jul-Sep  
Annual 

Dues 

Oct-Dec  Jan-Mar Apr-Jun 

Single: $24 $18 $12 $6 

Families: 
$30 $22 $15 $7 
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Up Coming Meeting for June 2019 
 

Note: Change to Summer Hours  
 

The next General Meeting of the 
PLATEAU PC USERS GROUP 

Will be on Tuesday, June 11th at 6:00 P.M. 
at Christ  Lutheran Church 

481 Snead Drive FFG 
(corner of Snead & Lakeview Drive) 

 

Cool Tips & Sites 

 

How to take a screenshot in  
Windows 10 

 
There are multiple ways to take a screenshot: 
 
Keyboard: Press Windows + PrtScn on key-
board 
The screenshot is saved in Pictures\Screenshots 
 
Tablets: Press Windows + Volume down on 
the tablet 
The screenshot is saved in Pictures\Screenshots 
 
Snip Tool: Press the Start button, then type 
"snip" 
Press New. Select the portion of the screen to 
save. Press the save button. 
 
Keyboard, alternate: Press PrtScn on key-
board. The screen is copied to the clipboard. 
Paste the screenshot into a program (e.g. Word, 
Paint) using Ctrl + V. 
 
Keyboard, alternate 2: Press Alt + PrtScn on 
keyboard. The open program is copied to the 
clipboard. Paste the screenshot into a program 
(e.g. Word, Paint) using Ctrl + V. 
 
 

 
News of the Special Interest Groups 

 

Plateau Photography Club 
  
In June 2018, the Plateau Photography and the Photo  
Editing Workshop Groups merged their monthly meetings 
into one meeting to be held on the third Thursday of each 
month, except for the months of December and February 
downstairs at the Fairfield Glade Library building (formerly 
the Multi-Purpose building), Room C, at 455 Lakeview 
Drive next to the swimming pool area. Enter the lower level 
from outside below the deck in back.  
  
Members of the PPCUG may attend at no charge; guests 
are asked to pay $3 for these workshops (the $3 fee is good 
for all meetings and workshops in the month paid). 
 
As more people take digital pictures, photo editing has be-
come a necessary and essential part of producing the final 
picture. Since over 95% percent of all pictures taken today 
are photo edited in some way, it was felt that the two topics 
should be combined in our meetings. 
  
The meetings will have monthly assignments covering a 
various categories.  Each member will be asked to bring the 
original picture taken and then explain the photo editing 
tools used to produce the final picture.  There will be dis-
cussion covering the picture itself and the tools used and 
why they were used.  Pictures with no photo editing are  
also welcomed. 
  
Each meeting will try to include short presentations on  
photography practices and/or photo editing techniques.   
 
The topics and assignments will be published in advanced 
to allow enough time for each member to plan and carry out 
their assignments.   The SIG leader is Jim Gries. at  
FGPhotographyclub@gmail.com 
  
 

 ** New look for PPCUG Website ** 
 

Visit our website at www.PPCUGinc.com. The 
Learning Center class schedule and Gazette are 
all available on our web site. 
 
Send your comments and suggestions to the  
Webmaster, Alan Baker 
Webmaster@ppcuginc.com  (931) 239-0877 
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Vote for PPCUG Officers Election in June 2019 

  

(For the period July 2019 though June 2020) 
  
Suggested candidates slated for PPCUG 

Board include: 
  
President: Steve Rosenstein 
Vice President & Compliance: Jim Buxton 
Treasurer: John Krueger 
Secretary: Linda Yates 
Past President: Carl Nordeen 
  
Directors at Large:  
  Gordon Botting   
 Barbara Duncan 
  Richard Del Frate 
  Bob Willis  
  Charlie Merrick 

******************** 

Tuesday, June  11th Meeting  

sleepyti.me 
 

This is a great little site that helps you understand the very best time to go to bed to get a good night's rest. 
Surprisingly, how much sleep you get, isn't the most important factor. 

What you do is put in the time you have to be up and the app will calculate when you should go to bed to get 
the best amount of rest. It even tells you to account for the 15 minutes it takes on average for people to fall 
asleep. 

 

This doesn't just tell you something you could figure out easily like, go to bed by midnight if you want to get 
up at 8:15 a.m.  It takes into account the body's sleep cycle and gives you multiple options for good times to 
set your alarm.  A good night's rest consists of five or six sleep cycles. If you are awakened in the middle of a 

(Continued on page 5) 
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sleep cycle, you are likely to feel groggy. Whereas if you get less sleep, but wake up at the end of a sleep cycle, 
you will fee refreshed. For example, if you need to be up at 5 a.m.,  8p, 9:30p, 11p, and 12:30 are the best times 
to hit the hay. 

 

It also works in reverse; you can select to find out when to wake up if you should go to bed now. Just click the 
zzz's button to switch the calculator over. 

What I really like is that this site is also very accessible for smart phones, tablets, and such. Just click the mo-
bile link if you are on a device, and you will get the interface designed for it.  

This has been so handy while traveling! I've actually played around with this a bit and put off going to bed for 
an hour or so, to hit the suggested wake-up time. And I think it works. You actually can feel more refreshed on 
five hours of sleep that you would with nine. 

I hope you'll check it out today! 

http://www.sleepyti.me/ 
 

The Winter 2019 Windows 10 Update 
 

By Rosita Herrick, Forum Moderator, Sarasota Technology Users Group, FL 
January 2019 issue, The STUG Monitor 
www.thestug.org 
hrosita (at) aol.com 
 
By now, some of you have already updated to the current version of Windows 10 and, if not, you should soon 
receive the update on your computer. Once your PC is updated, the Windows version will show as Version 
1809 (OS Build 17763.134) 
 
Listed below are five additions that come with this update and that I found useful for the average user 
 
1. A new Snip and Sketch app (that will eventually replace the Snipping Tool) was added that supports the use 

of a stylus and the option to start it with the shortcut Win key + Shift + S. 
 
 

 

(Continued from page 4) 

(Continued on page 6) 
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2. Change System font size 
Using a new slider, it is easy to adjust the font size for the Start menu, titles, 
message boxes, and tool tips for all apps. Select Settings and enter Make text 
bigger in the search box. To increase the size of text on your screen, adjust the 
slider under Make text bigger. To make everything larger, including images 
and apps, choose an option from the dropdown menu under Make everything 
bigger. 

 
3. Cortana 

 The display that pops up when the user clicks on the Cortana 
search box has changed. As you can see below, you can click 
on any of the blue boxes to limit where Cortana looks for the 
search argument. Also, below the boxes the links displayed are 
the items the user had worked on previously. As you can see, 
the first item is the title of the Word document that I am prepar-
ing for the Monitor, so I can pick it up later if I have to stop at 
any time. 
 
 
 
 

 
4. There is now a new keyboard short cut to start a second 

screen of an active app. The shortcut is Ctrl + N. For ex-
ample, in the picture below I have an open File Explorer 
screen . Pressing the shortcut Ctrl + N gave me a second 
screen. This is very handy when you want to copy or 
move either a file or folder from one place to the other. 
The pages can be separated by clicking on the blue bar of 
the active screen and dragging the page. 
 
 

5. The new Cloud-powered clipboard introduces a new interface (which you can invoke us-
ing the Windows key + V shortcut) to view your history, paste previous content, and pin 
items that you may need to paste in the daily basis. 
 

  
 

6. Search experience 
Searching for an app or document, the right pane will now 
show common actions, including options to run an app as an 
administrator, file information, such as path and the last time 
the document was modified, and more.  
 

 
 

(Continued from page 5) 
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Six Little Word Problems and their Solutions 
 

By Nancy DeMarte, 1st Vice President, Sarasota Technology User Group, FL 
November 2018 issue, STUG Monitor 
www.thestug.org / ndemarte (at) verizon.net 
 
1. You print a multi-page Word document and get an unexpected blank page at the end of the document.  
Because it has a footer, you won’t be able to use that sheet for anything except scrap paper. 

 
Solution: Before you click  Print, press the Show/Hide key on the Home tab > Paragraph group and scroll 
or press the Ctrl+End keys to get to the end of the document. You will see one or more paragraph icons on the 
last blank page.  Select them and press Delete. Then save the document to avoid the blank page in future print-
ings. 
 
2. You open a document and find you have to squint to see the small type.  
Solution: Go to the Zoom slider at the bottom right of the screen and click the + 
sign a few times until the document text is large enough to be comfortable for 
your eyes. This will not affect the text size when printed. 
 
3. You are just about done typing a Word document and notice that all the text 
in the last couple of sentences is in upper case. You had pressed the Caps Lock 
key on the keyboard accidentally.  
 
Solution: First select the text you want to reformat. Then click the Change 
Case tool (Aa) on the Home tab > Font group. Click the case pattern you want 
from the list, which in this situation is probably “Sentence case.”  
 
 
 
4. Sometimes you forget what version of Windows you have on your computer. “Version” includes the oper-
ating system (Windows 7, 8.1, or 10) and the Windows update version number, such as the recent update, 
1803. But you’re not sure how to find the answer. 

 
Solution: To find the version of your Windows operating system, type in the Search box at the bottom left of 
the taskbar the word winver. Then click the winver run command to see your computer’s details. 
 
 
5. When you enter an email or web address in a document, by default Word 
automatically adds a hyperlink to the address. You can identify a hyperlink by 
its blue text and underline. Many times, you don’t want the hyperlink includ-
ed. 
 
Solution: There is a way to change the setting to stop the automatic hyperlink 
from being added.  
Click the File tab (top left of the ribbon), then click Options (last item on the 
menu). Click Proofing > AutoCorrect options > Autoformat and uncheck the 
last item on the Replace list, “Internet and network paths with hyperlinks,” 
then click OK.   
 
 

(Continued on page 8) 
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Just to be safe, also click “Auto Format As You Type” and uncheck the same box there, followed by OK. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

While you are in the Word AutoCorrect area, check to see if you are being bothered by any other automatic 
action. If so, uncheck it and click OK. 
 
If you change your mind, return to this screen and re-check the boxes. 
 
6. You have typed a long list of items, such as book titles, taking up several pages of a Word document. Each 
title is on a separate line. You would like to find out how many items there are in the list, but counting them 
would be tedious. 
 
Solution: Select the entire list using Ctrl+A. Then on the Home tab - Paragraph group, click the numbering 
tool (top row, second from left) to place a number in front of each item. Then press Ctrl+End to jump to the 
end of the list, where you can view the last number. If you wish, then press Ctrl+Z or Undo to remove the 
numbering. 
 
 
 

SD Card Readers 
 

Review of presentation by Susan Malloy, Secretary,  
Northern Neck Computer User Group, NY 
Review by George Cadmus 
December 2018 issue, The Computer Link 
www.nncug.org 
geocadjr (at) verizon.net 
 
At a recent NNCUG meeting, Susan showed and explained an SD card reader that she uses. A memory card 
reader is a device that can read flash memory cards and transfer their contents to a computer. Flash memory 
cards come in various types and formats, providing removable storage for digital equipment like camcorders, 
cameras, MP3 players and cell phones. There are single and multiple card readers, and while the former can 
only read a single memory card type, the latter can read a variety of formats.  
 
Without a memory card reader, a person has to directly connect the physical device that uses memory cards to 
the computer. This is usually done with a Universal Serial Bus (USB) or Firewire cable. The advantage of a 

(Continued from page 7) 

(Continued on page 9) 
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reader is that memory cards can be read directly on the computer without attaching the device. This greatly 
simplifies using, storing and organizing the cards. It also saves batteries and wear and tear on the camcorder 
or other digital device. 
 
It is common for people to own more than one device that uses flash memory cards, with each device using a 
different type of card. A multiple card reader will accept a variety of formats, making it useful for all of your 
memory card needs. These readers commonly feature two or more slots to accept different sized cards. Some 
memory card readers are extremely compact, barely larger than the cards they read. These plug directly into 
the USB port and are about the size of a memory stick. Others are designed to be internally installed into a 
free bay on desktop computers, with an array of choices between these two models. One advantage of the 
external model is that it is portable, able to be used with multiple computers and/or laptops in the household.  
 
Many newer computers, including many laptops and notebooks, have a card reader built-in by default. Print-
ers and even some monitors may have them as well, so that the information on the cards can easily be printed 
or displayed. Anyone who has been thinking about replacing an aging desktop, laptop, printer or monitor, 
might look into these options first.  
 
When buying a reader, consumers should be sure it supports the type of card(s) required. This includes the 
card's capacity in addition to the format. Some models might not read flash memory cards larger than 1 GB, 
for example. Shoppers should also bear in mind too that a more flexible card reader that supports additional 
formats might make the device a little more future proof in the event that hey acquire more digital devices 
later or replace the ones they already own.  
 
Memory card readers are typically extremely affordable, and they can be found at many online retailers and 
local suppliers of computers and digital equipment.  
 
To see a video on SD card readers, click on the link. https://binged.it/2C6fUDg  
 
 
 
 
 

 Taming E-mail 
 

By Dick Maybach, Member, Brookdale Computer User Group, NJ 
www.bcug.com 
n2nd (at) att.net 
 
Like many others, I rely on e-mail as my primary means of communication, and almost every day I deal with 
messages that are important to me. The problem of course is to sort them out from the deluge of those that 
are not. My e-mail vendor does a good job of removing most spam, but still much of what I do see is unim-
portant. Today I’ll be discussing strategies to make the important messages more accessible than those that 
are less so. The implementation details will depend on how you access your mail, in particular whether 
through a Website of with a client program on your PC. 
 
Back in the communications-by-paper era, common advice to improve your efficiency was to touch docu-
ments on your desk only once. That is, deal with them the first time you see them. Today the equivalent ad-
vice is to move messages from your e-mail inbox the first time you read them. For most messages this is read
-and-delete, but you will probably want to file a few, such as those with purchase receipts.  

(Continued from page 8) 
 

(Continued on page 10) 
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Touch-once is a goal, but for me at least, an unattainable one. However, by working toward it you will be 
improving your efficiency. 
 
I use the Thunderbird e-mail client program, which has a message filter feature. This scans fields in each in-
coming message, looking at the sender, subject, body, age, size, etc., and acts according to their contents. 
Each can be deleted, put in a folder, marked as read, etc. Most e-mail clients and Webmail sites have similar 
tools. 
 
If you correspond with only a few, you might classify as spam all messages except those on an OK list, such 
as your address book. You will probably have to check the spam folder fairly regularly to be sure you don’t 
miss something important. This strategy wouldn’t work for me is as I run an organization’s Website and 
sometimes get questions from its members. I do want to see these, even though I may never have communi-
cated with the senders. Instead, I accept all messages except those that meet specific criteria. 
 
I have found that most forwarded messages are unimportant, and many are frivolous. As a result, all messag-
es with subjects beginning “Fwd:” are immediately sent to the FWD folder. I do look here every day or so, 
because these are often from friends, although almost never do they require a response, and I don’t want pic-
tures of cute animals cluttering my inbox. 
 
There is also an Ads folder, and incoming mail from many merchants immediately goes there. This isn’t 
spam, as I do deal with the senders and will again, but some send me several messages a week, and I have no 
need to deal with them immediately. Of course, it takes a while to develop a set of filters. When I get a new 
ad, I have to decide if this is likely to be frequent enough to make it worthwhile to define a filter. Every day 
or two, I do scan through the Ads folder in case there is something interesting (there seldom is) and delete 
everything else. 
 
My ISP does a good job of filtering spam before I see it. Sometimes too good, I occasionally find valuable 
messages in the Website spam folder. 
 
Most e-mail programs have a feature similar to what Thunderbird calls the message filter. For example, Fig-
ure 1 shows the filter to file forwarded messages. 
 

 
Figure 1. FWD Message Filter. 

(Continued from page 9) 
 

(Continued on page 11) 
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As you can see, any message whose subject contains “Fwd:” is sent to the local folder FWD. Note that some 
fields are drop-down lists. For example, Figure 2 shows the alternate choices to these. As a result you have 
considerable flexibility in setting up your filters. 
 
 
 
 

 
 
Figure 3 shows the AT&T Webmail screen to define an E-mail message filter, which has features similar to 
Thunderbird’s. 
 

(Continued from page 10) 
 

(Continued on page 12) 

 

 

 

Figure 2. Alternate  
Choices for Subject, 
contains, and Move 
Message to. 

  



Gazette May 2019     www.PPCUGinc.com                                                    Page 12 

 
Figure 3. AT&T E-mail Message Filter Definition. 
 
 
So far, we’ve discussed diverting messages from the inbox, but you probably also want to organize the 
storage of mail you’ve read but need to retain. For this purpose I’ve created folders to collect those mes-
sages, such as BCUG, Finance, Medical, Orders, Personal, and Travel. This makes them easier to locate 
than if they were somewhere in my inbox. 
 
Every so often, I delete most of the old messages, regardless of in which folder they reside. Once I’ve  
returned from a trip, I really don’t need its boarding passes, and once an order is delivered, I don’t need its 
tracking number. 
 
Periodically, check the server, even if you download all your messages to client software on your PC. You 
may find a valuable message in its spam folder. It’s also a good idea the clear out old messages, as occa-
sionally there are reports of ISP break-ins. You may feel you have nothing to hide, but they probably  
contain details of your life you don’t want in the wrong hands. 
 
You most likely use e-mail differently than I do, and you probably use different tools to manage it, but you 
probably also get dozens of messages each day, making it worth taking a little time to develop an appropri-
ate strategy to deal with them efficiently. 

(Continued from page 11) 
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How to stay on course when scrolling up & down a web page 
 

By John Krout, Member, Potomac Area Technology and Computer Society, VA 
www.patacs.org 
krout75 (at) yahoo.com 
 
At a recent PATACS/OLLI meeting in Fairfax City, a question was raised about scrolling up and down a 
web page: why does the browser sometimes suddenly revert to the top of the page? 
 
This experience, no doubt familiar to many of us, has to do with pointing device behavior. With a normal 
mouse or track ball, you click and hold the button down on the vertical scroll bar on the far right of the 
web page, and then drag the scroll bar up and down. 
 
While doing that, often you are intently reading the visible portion of the web page, and not watching the 
mouse pointer. I run into this a lot when examining the CNN.com home page. It is easy to let the mouse 
pointer drift slightly right or left. When the pointer moves off the vertical scroll bar, the web page auto-
matically reverts to the top of page. 
This much I explained at the meeting.  
 
Another member proposed a solution, one that I had not previously thought of, and I think it is a very use-
ful solution: obtain a trackball or mouse with a vertical scroll wheel.  
Instead of moving the pointer in the familiar way, simply rotate the scroll wheel. Up and down the page 
goes, very reliably, with no drift. 
 
Now, if the problem described above is unfamiliar to you, then read no further. The rest of this article is a 
brief survey of products you may wish to know about if the problem is one you would like to solve.  
 
After the meeting, I took a look on the Web at mouse and trackball products including such a wheel. They 
are not very expensive. 
 
This is not a recommendation or a review. I just want to show you the bottom of the price range and some 
options. 
 
From here on I focus on products available from Amazon because of the small commission paid to 
PATACS by Amazon when you use the link to Amazon appearing on the PATACS.org home page and 
you spend money on Amazon. The sum total of that income to PATACS from Amazon was a few hundred 
dollars in the last full fiscal year for the club. That is equivalent to 20+ additional dues-paying PATACS 
members, far more than I expected, and is why the club offers that opportunity. 
 
I used this search on Amazon: mouse with scroll wheel. Then I sorted on low price to high price. 
 
On Amazon, I found there are USB scroll wheel mouses for less than $10, and wireless and Bluetooth 
scroll wheel mouses for less than $20. All provide a wheel on the top of the mouse, equally accessible for 
right handed and left-handed use. You will see many such products, even in a choice of colors.  
 
I happen to use a USB trackball for my desktop computer at home, partly because the open space on my 
desk is often not sufficient for moving a mouse around. So I also looked at trackballs equipped with a 
scroll wheel. 
 

(Continued on page 14) 
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I used this search on Amazon: trackball with scroll wheel. Then I sorted on low price to high price. 
 
It happens that several such trackballs exist. USB trackballs with scroll wheel start at less than $25.  
 
Logitech tends to put the scroll wheel on top and the ball on the side, which means it is difficult for left-
ies. Maybe they make left handed versions; I did not nose around enough to find out. 
 
I found a very interesting innovation from Kensington, the trackball brand that I have been using. Their 
trackball scroll wheel is in fact a ring around the centered trackball.  
Incidentally, in that same set of Amazon search results, I also found keyboards with a trackball and scroll 
wheel built in. As you might guess, these are more expensive than standalone trackballs, but if your desk-
top real estate is extremely limited, the all in one keyboard may be of interest to you.  
 

 
 
 
 

 
 
 
 
 
 
 
 
 
 

(Continued from page 13) 
 

Kensington wired mouse Logitech wireless trackball 
with scroll wheel 

Kensington trackball 
mouse with scroll ring 
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PLATEAU PC USERS GROUP, Inc. 

APPLICATION FOR MEMBERSHIP 

  

          ____ New Member                    ____ Renewing Member 
  

  

Return this application, with check for annual dues payable to "PLATEAU PC USERS GROUP." Return to the club 
Treasurer during our meeting or mail to PPCUG Treasurer. P.O. Box 3787, Crossville, TN 38557. Our annual dues are 
now payable on July 1st of each year.  Annual dues are $24 per single person / $30 per family starting 7/1/2014 with 
partial years’ dues as follows: 
 

 

 

Join In 
July-Sept 

Annual Dues 
Oct-Dec Jan-Mar Apr-June 

Single: $24 $18 $12 $6 

Families: $30 $22 $15 $7 

  

    

Date: ______________           Amount Paid: $ ____ :.00,  by Cash ___ , or    Check ( #_____________ ) 
                                                

    _____________________________________________ ________________________________  _____________________________________ 

          Last Name         First Name Family Members (if family membership) 

_______________________________________________________________________ 

           Address:  

____________________________          _____ _____________ (_____  )____________________ 

    City                        State     Zip Code Phone Number 

 
E-Mail address:  —————————————————————————————— 
 

 
I have belonged to a Computer Club before. Yes    _____    No _____ _ 
 
l have used PCs since (year):   __________     
 
I have knowledge in the following areas that I would be willing to share with club members:  
 
______________________________________________________________________________ 
 
______________________________________________________________________________ 
 
______________________________________________________________________________ 
 
 
January 2019 
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Note:  Please see page #15 for the Plateau PC Users Group, Inc. Application for Membership form. 

June 2019 

Sun Mon Tue Wed Thu Fri Sat 

      1 

2 3 4 5 2:00 P.M. 

PPCUG Board 
Mtg. 

6 7 8 

9 10 11 6:00 P.M. 

General Mtg.  
Presentation. 
Followed By 
Q&A Session 

12 13 14 15 

16 17 18 19 20 1:00 P.M. 

Plateau Pho-
tography Club 
Workshop 
Mtg. 

21 22 

23 24 25 26 27 28 29 

30       


